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Licenses
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT COMPLIES WITH 
THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY 
PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG LA, LLC, 6312 S. Fiddlers Green Circle, Suite 400E, 
Greenwood Village, Colorado 80111 U.S.A.

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND 
NONCOMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC 
STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE 
HTTP://WWW.MPEGLA.COM

This product contains one or more programs protected under international and U.S. copyright 
laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their 
reproduction or disclosure, in whole or in part, or the production of derivative works therefrom 
without the express permission of Dolby Laboratories is prohibited. Copyright 2003-2009 by Dolby 
Laboratories. All rights reserved.
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1.0 Introduction
1.1 Safety Instructions
DO NOT INSTALL YOUR RECEIVER:

�� In a closed or poorly ventilated cabinet; directly on top of or under any other equipment; on a 
surface which might obstruct the ventilation slots.

DO NOT EXPOSE THE RECEIVER OR ITS ACCESSORIES:
�� To direct sunlight or any other equipment that generates heat; to rain or intense moisture; to 

intense vibration and to any shock which may cause permanent damage to your receiver or to 
any magnetic objects, such as loudspeakers, transformers, etc.
�� Do not use a damaged power cord. It may cause a fire or an electric shock. Do not touch a 

power cord with wet hands. It may cause an electric shock.
�� When the receiver is not used for a long period of time, you should unplug the power cord 

from the wall socket.
�� Do not use alcohol or ammonia based liquids to clean the receiver. If you wish, you may clean 

your receiver with a soft lint-free cloth slightly made damp with a mild soap solution, and only 
after disconnecting from the mains voltage supply. Make sure no foreign objects fall through 
the ventilation slots because this could cause fire or an electric shock.
�� Do not place any objects on top of the receiver because this might prevent proper cooling of 

the components inside.

Safety Precautions
�� Never try to open the receiver. It is dangerous to touch the inside of the receiver due to high 

voltages and possible electrical hazards. Opening the receiver will void the warranty of the 
product. Refer all maintenance or servicing to suitably qualified personnel.
�� When you are connecting cables, be sure that the receiver is disconnected from the mains 

supply voltage. Wait a few seconds after switching off the receiver before you move the 
receiver or disconnect any equipment.
�� It is a necessity that you only use an approved extension and compatible wiring that is suitable 

for the electrical power consumption of the installed equipment. Please ensure that the 
electrical power supply corresponds with the voltage on the electrical identification plate at the 
back of the receiver.

If the receiver does not operate normally even after strictly following the instructions in this user 
manual, it is recommended to consult your dealer.

1.2 Storage
Your receiver and its accessories are stored and delivered in a packaging designed to protect against 
electric shocks and moisture. When unpacking it, make sure that all the parts are included and keep 
the packaging away from children. When transporting the receiver from one place to another or 
if you are returning it under warranty conditions, make sure to repack the receiver in its original 
packaging with its accessories. Failing to comply with such packaging procedures could damage the 
product and void your warranty.
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1.3 Equipment Set-up
We recommend you consult a professional installer to set up your equipment. Otherwise, please 
follow the instructions below:

�� Refer to the user manual of your TV and, if applicable, your antenna.
�� Make sure that the HDMI cable and, if applicable, outdoor components are in a good condition.
�� If you use TV SCART connection, use then well shielded SCART cable.

This user manual provides complete instructions for installing and using this receiver. The symbols 
serve as follows.
Warning	 Indicates warning information.
Tips	 Indicates any other additional important or helpful information.
MENU	 Represents a button on the remote control or the receiver. 
(Bold characters) 
Move to	 Represents a menu item within a window. 
(Italic characters)

1.4 Accessories
�� Quick Installation Guide
�� 1 remote control unit
�� 2x batteries (AAA type)

Warning	� The batteries should not be recharged, disassembled, electrically short-
circuited, be mixed or used with other types of batteries. If rechargeable 
accumulators instead of batteries are going to be used (e.g. NiMH), we 
recommend using types with low self-discharge to ensure long time 
operation of your remote control.

1.5 Usage of external USB devices
�� It is recommended to use USB 2.0 storage devices or higher. If your device is not compatible 

to USB 2.0 specifications, recording, playback and other multimedia functions of the receiver 
might not work properly.
�� To ensure best performance of your USB storage device please format it via your receiver 

(through the menu “Media”) to FAT32 system. Other file systems are not supported by the 
receiver. However, it is possible to use already NTFS formatted disks. 
�� STRONG cannot guarantee compatibility with all types of USB storage devices.
�� If you are going to use external USB HDDs (Hard Disk Drives), please consider that power 

specifications may exceed the supported output of your receiver (max.5 V/800 mA). If so, please 
connect your USB HDD to an according external power adapter.
�� It is advised not to store important information on USB storage devices used with the receiver. 

Always make backups of data on your USB storage device before using it with this receiver. 
STRONG will not take responsibility for any loss of information or circumstances caused by loss 
of information.
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2.0 Your Receiver
2.1 DEFAULT PIN: 1234

2.2 Front Panel
Fig. 1

1.	 IR sensor	� Point your remote control towards this sensor.
2.	 Mode indicator	� RED indicates that the receiver is in STANDBY mode.  

GREEN indicates that the receiver is in OPERATING mode.
3.	 USB	� Connector for USB storage devices.

2.3 Rear Panel
Fig. 2

1.	 ANT IN	� To connect to your antenna for reception of broadcasted signals. 
2.	 ANT OUT 	� To connect the terrestrial antenna signal to your TV set. This 

connection will allow you to watch digital terrestrial programmes 
depending on the tuner of your TV and local broadcast 
conditions

3.	 S/PDIF Coaxial 	� To connect your receiver to a digital home theatre, AV receiver or 
digital audio amplifier.

4.	 HDMI	� To connect your receiver with your TV set using an HDMI cable.
5.	 TV SCART 	� To connect your receiver with your TV set using a SCART cable.
6.	 Audio L/R	� To connect your receiver to an analogue audio amplifier.
7.	 Power cord	� Your receiver requires a supply voltage of 220 – 240 V AC 

(Auto-selectable), 50/60Hz +/-5%. Please ensure the local power 
specification meets these requirements before connecting your 
receiver to the wall outlet.

2.4 Remote control 
Fig. 3

1.	 q	� Switches the receiver On/Standby
2.	 !	� Mutes all audio outputs of the receiver
3.	 PG+/PG-	� Page up/down in all list modes
4.	 DTV/VCR	� No function
5.	 INFO	� Opens the current channel information; 2x opens the current 

event information and 3x the signal information
6.	 VOL+/VOL-	� Increases/decreases the volume level
7.	 MENU	� Opens the main menu, in a menu you will get one step back 
8.	 EXIT	� Exits from the menu or sub-menu 
9.	 pq	� Menu Off: Change channel to next/previous. 

Menu On: Moves the cursor up/down.
10.	tu	� Menu Off: Decreases/ increases the volume level. Menu On: 

Change settings for specific menus 
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11.	OK	� Menu Off: Displays the current channel list Menu On: Activates 
the highlighted menu item. 

12.	RECORD	� Records the TV programme to the connected USB storage device
13.	TIMESHIFT	� Activates the Timeshift function (Off/On)
14.	0~9	� Enters a channel number in viewing mode or a value inside the 

respective menu
15.	EPG	� Opens the EPG (Electronic Programme Guide) in TV mode 
16.	RECALL	� Back to previously watched channel
17.	AUDIO	� Opens the audio language selection 
18.	TV/RADIO	� Toggles between TV or RADIO mode
19.	FAV	� Opens the favourite group selection
20.	FILE	� Opens the Media Player list
21.	TTX	� Displays Teletext on the OSD (On Screen Display)
22.	SUBTITLE	� Shows a list of subtitle languages
23.	56	� Fast rewind/fast forward
24.	Coloured buttons	� For Multimedia and Teletext functions

2.5 Installing the batteries
Fig. 4

Open the cover on the remote control and insert 2x AAA batteries into the compartment. Correct 
position of the polar diagram shows the batteries inside the compartment.

1.	 Open the cover.
2.	 Insert the batteries.
3.	 Close the lid.

WARNING	� The batteries should not be recharged, disassembled, electrically short-
circuited, be mixed or used with other types of batteries.

2.6 Using the remote control
Fig. 5

To use the remote control, point it towards the front of your receiver. The remote control supports a 
range of up to 5 meters distance to the receiver at an angle of up to approx. 30 degrees.

NOTE	� Managing the receiver will be limited or not possible if there are obstacles 
between the remote control sensor (at the front panel of the receiver) 
and the remote control. Direct sunlight or very bright light can reduce or 
disturb the reception of the remote control signals.
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3.0 Connections 
3.1 Connecting to a terrestrial antenna

Fig. 6
To receive broadcasted signals, your terrestrial indoor or outdoor antenna must be connected to the 
ANT IN connector on the back of the receiver. Use a properly shielded antenna cable and suitable 
connectors. The ANT OUT connector allows you to loop the antenna signal to a second receiver or 
TV set. 
Please consider that the looped signal might be too weak if you use an active antenna.

Note	� If the signals at your location are too weak to receive proper signals with 
an indoor antenna, we recommend using an outdoor antenna which can 
be pointed towards the transmission tower. Ask your local dealer for more 
information.

3.2 Connecting to TV with HDMI cable
Fig. 6

The TV set shall be connected with the receiver using a good quality HDMI cable. This connection 
gives the highest possible quality.

3.3 Connecting to TV with SCART cable
Fig. 6

Your receiver is also equipped with a SCART connector; alternatively, the TV set can be connected to 
the receiver using a good quality SCART cable.

3.4 Connecting to a Digital Audio Amplifier with S/PDIF
Fig. 6

By connecting your receiver to a digital amplifier or home theatre system, you can enjoy the best 
possible sound quality and multi-channel audio (depending on the broadcast). Connect your Digital 
Audio Amplifier or home theatre system with a suitable cinch cable to the S/PDIF connector on the 
back of the receiver. 

3.5 Connecting to a digital audio amplifier and TV using 
HDMI 

Fig. 6
By connecting your receiver to the latest digital amplifiers or Home Cinema systems you will enjoy 
the best possible sound quality and multi-channel audio (depending on the broadcast). Connect the 
HDMI output of the receiver to an input of your amplifier, and then connect the HDMI output of the 
amplifier to your TV set. Select the correct input on your amplifier to watch and listen to programmes.
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3.6 Connecting to an analogue Audio Amplifier
Fig. 7

Use the 3.5 mm jack to connect your receiver to the analogue input of your Hi-Fi or audio amplifier 
with a 3.5 mm jack to RCA cable for achieving best possible analogue audio quality.

3.7 Connecting a USB storage device
Fig. 8

Connecting a USB device to the unit allows you to playback movies, music and picture files which are 
stored on it. See chapter 7.5.1. Mediaplayer.  Additionally, TV programmes can be recorded, put on 
hold (Timeshift) and played. See chapter 6. Operation.

Note	� It is recommended to use USB 2.0 storage devices or higher for recording 
and playback of TV programmes or HD movies.

 

Note	� Timeshift/recording and playback only work properly when a fast USB 
storage device such as a USB2.0 HDD is connected to the receiver. 
Timeshift/recording and playback of HD content require a sufficient read/
write speed of the used USB storage device.

4.0 Starting up for the first time 
When you use your receiver for the first time, the Welcome “Easy install” menu appears. Use pq to 
move the highlight to the setting you wish to alter and use tu to change values. Start by selecting 
your language using tu. Once you have selected your language, press q to move the highlight to 
the next item and use tu to change.
Language	 Here you can choose your language.
Region: 	 Select your region where this receiver is used.	
Subtitle: 	� Select Normal to display subtitles per default, Select Hard of Hearing to show 

HoH subtitles per default. Select Off to hide subtitles per default.*
Aspect Mode: 	� Use this option to select the aspect ratio of your TV and the preferred 

conversion method. The options are: Auto (automatic detection of aspect 
ratio), 4:3 Panscan (Displays 16:9 widescreen broadcasts full screen on your 
4:3 TV), 4:3 letterbox (black bars on top and under the picture on a 4:3 TV) and 
16:9 (use this setting for 16:9 TV sets).

Scan mode: 	� Select All to store scrambled and free to air channels or select Free to store 
only free to air channels. Note: Scrambled channels cannot be viewed with 
this receiver.

Connection: 	� Use this option to adjust the established connection to your TV set. Select 
HDMI or TV SCART. 

*Availability of DVB/HoH subtitles depends on the broadcast. If subtitles are not supported, they can be activated via 
Teletext, if available.
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When all settings have been made, move the highlight to OK and press OK to continue.

Note	� Wrong region selection can lead to missing channels or channels being 
stored at wrong positions in the channel list.

The receiver will now advance to the Aerial Adjustment screen.
This part of the wizard is of great help when setting up your antenna system. 
Use pq to move the highlight to the setting you wish to alter and use tu to change values. The 
following settings are available:
Antenna Power: 	� Set to On if you use an active antenna. When set to On, 5 V will be present at 

the ANT IN connector of the receiver. Select Off for passive antennas. 
Beeper: 	� Select On for an audible indication of signal reception. Off turns the beeper 

off.
Channel No.: 	� Select a channel that is known to carry a broadcast in your region. The Signal 

Strength and Signal Quality bars give a visual indication of the reception. 
Adjust your antenna to obtain maximum signal strength and quality. 

When all settings have been made, press OK to start scanning. 
The receiver will search for all available channels now. Once scanning is finished, the receiver switches 
to viewing mode.

TIP	� If the Welcome menu does not appear after switching on the receiver 
the first time, reset the receiver to factory settings by pressing the MENU 
button and selecting Load Factory Setting in the submenu Tools. (DEFAULT 
PIN: 1234).

5.0 Quick guide to using your receiver
We at STRONG understand that you can’t wait to enjoy your new digital terrestrial HD receiver. The 
following quick guide will make you familiar with the basic operation of this device. We do, however, 
advice you to read the full manual to get the best performance from your receiver. To turn your 
receiver ON or to Standby, use the q button on the remote control. 
Choose a channel with pq. Alternatively, you can digit the channel number with the 0~9 buttons 
on the remote control or press OK in viewing mode to display the channel list. The volume can be 
adjusted with tu.

6.0 Operation
6.1 Changing channels
Following ways are possible for changing channels with your new receiver:

�� Via direct access using the 0~9 buttons.
�� Via the channel list using OK and the PG+/PG- buttons.
�� Via the pq buttons.
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6.1.1 Direct access via 0~9 buttons
To gain direct access to a certain channel, simply input its number with the 0~9 buttons on the 
remote control. Channel numbers can be up to four digits long. Entering a number with less than 
four digits is possible. Just wait a few seconds and your receiver will switch to the selected channel or 
press OK immediately after selecting the channel number.

6.1.2 Channel list
Press OK in viewing mode to display the Channel List. Use pq in the channel list to highlight your 
channel of choice and press OK once to select the highlighted channel. Press OK again to leave the 
channel list mode. Inside the channel list it is possible to use the PG+/PG- buttons as well in order to 
scroll page-wise through the list. 

TIP	� Use tu to toggle between the All Channel list and favourite list(s) or press 
FAV in viewing mode for a list of the available favourite lists.

6.1.3 Using the pq buttons 
p switches to the next channel.
q switches to the previous channel.

6.2 Info Banner
While watching TV you can press the INFO button at any time to access current information about 
the channel and event*. Press INFO twice for extended EPG details about the current channel. Press 
INFO three times for technical details about the current channel.

*Event information is displayed when available. Availability depends on the broadcast.

6.3 Selection of audio language
Some channels support a choice of audio formats and/or languages. To select another audio stream, 
press AUDIO in viewing mode. A list with available audio streams will now be displayed. Use pq 
to select a stream and confirm with OK. The audio channel as stereo, mono, left and right can be 
selected with the tu buttons.

6.4 Teletext
Your receiver includes a fully featured Teletext. To access Teletext, press the TTX button in viewing 
mode and use the 0~9 buttons to input the number of the page you wish to see. The coloured 
buttons of the remote control allow you to jump to selected pages directly, as indicated on the 
bottom of the Teletext screen. Use the pq buttons to select one page up or down, use the tu 
buttons to select subpages. Press EXIT or TTX to get back to viewing mode.
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6.5 Subtitles
Some channels support a choice of subtitle languages. Press SUBTITLE in viewing mode to display a 
list of available subtitle languages. Select your subtitle of choice with pq and press OK to confirm. 
Press EXIT to leave without making changes.*

*Availability of DVB/HoH subtitles depends on the broadcast. If subtitles are not supported, they can be activated via 
Teletext if available.

6.6 Timeshift
Timeshift allows you to pause live broadcasts and resume playback later. To activate this function set 
the Timeshift mode in the DVR Setting menu to on by selecting Pause. For details, see 7.6.3. Press 2 
in viewing mode to activate Timeshift. The progress information banner appears on screen. Live TV 
keeps playing for moment and will then pause. Press u to resume Timeshifted playback. Press 3 to 
return to live TV.

Note	� Timeshift and its playback only work properly when a fast USB storage 
device such as a USB2.0 HDD is connected to the receiver. Timeshift and 
playback of HD content requires sufficient read/write speed of the used 
USB storage device .

6.7 EPG (Electronic Programme Guide)
The Electronic Programme Guide is a very useful function that allows you to view event schedules 
and programme information and to mark events/movies for recording. To access the EPG, press the 
EPG button in viewing mode. Use pq to select a channel and tu to select an event. Press OK to 
display detailed information of the selected event. Use EXIT to quit the detailed information screen. 
Press RED to access further step functions. Use tu to select a step and OK to execute it. Press EXIT 
to quit the step function. Press GREEN to set a timer for a selected event. Refer to section 7.3.4 for 
details of the timer function.

Note	� Availability of EPG data depends on the broadcast. 

6.8 Instant Recording
Your new receiver allows you to make an instant recording of the programme you are watching. 
Simply press RECORD to start the recording. To enter the duration for the recording, press RECORD 
again. Use the 0~9 buttons to enter the recording time and press OK to confirm.
At the beginning of the recording a recording sign will be shown for a short while on the upper left 
corner of your TV screen. To stop the recording, press 3. Select Yes and press OK again to stop the 
recording. It is possible to make 2 recordings at the same time if they are broadcasted on the same 
frequency.
You can access the Record Manager via the FILE button, and select Record by pressing the button 1. 

*Please connect a USB storage device with sufficient free space before you start a recording. 
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7.0 Main Menu
The main menu gives you access to settings, multimedia functions and games. To access the main 
menu, press MENU in viewing mode. The main menu consists of the following sub menus: Edit 
Channel, Installation, System Setup, Tools, Games and Media.
Throughout the main menu, MENU or EXIT can be used to get back to the previous screen.

7.1 Edit Channel 
Use pq to select Edit Channel and press OK or u to enter.
Use pq to highlight the submenu of choice and press OK to select.
Press EXIT or t to get back to the main menu.

7.1.1 TV Channel List
In the Edit Channel menu select TV Channel List with pq and press OK to enter.
Use tu to change the channel group (if you have already set up favourite groups).
Select the channel of choice with pq. Press OK to view the selected channel in the preview box.

7.1.1.1 Adding channels to favourite lists
Channels from the TV Channel List can be added to up to 8 different favourite groups. Press FAV in 
TV Channel List to access this function. The FAV sign on the top of the screen will move up to indicate 
that the favourite function is selected. Use pq to select a channel you wish to add to a favourite 
group. When the highlight is on the channel of your choice, press OK. A list with all available favourite 
lists will now pop up. Use pq to select the favourite list you wish to add the channel to and press 
OK, press EXIT to finalize the process. Favourite channels will be marked with . When all changes 
have been made, press EXIT twice. A confirmation banner will pop up. Select Yes to save the changes 
or No to discard. 

7.1.1.2 Locking channels
Locked channels can only be watched after entering the PIN code. (DEFAULT PIN: 1234)
To lock or unlock a channel, press RED while in TV Channel List. Press pq to select a channel and 
press OK to lock or unlock it. You are asked to input the PIN code. (DEFAULT PIN: 1234 Locked 
channels will be marked with the  symbol. Locking/unlocking multiple channels in one session is 
possible. When all changes have been made, press EXIT twice. A confirmation banner will pop up. 
Select Yes to save the changes or No to discard. 

7.1.1.3 Skipping channels
Channels marked with Skip will be skipped when zapping channels with the pq buttons. The 
channels will still be available from the channel list.
To mark channels for skipping, press GREEN while in TV Channel List. Use pq to select a channel 
and press OK to mark or unmark it for skipping. Channels set for skipping will be marked with the 
 symbol. When all changes have been made, press EXIT twice. A confirmation banner will pop up. 
Select Yes to save the changes or No to discard. 
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7.1.1.4 Moving channels
To enable the Move function, press YELLOW while in TV Channel List. Use pq to select a channel 
and press OK to select it. Now you can move the selected channel up or down inside the channel list 
by using pq. When the channel is on the position of your choice, press OK again. The channel is 
now fixed on its new position. When all changes have been made, press EXIT twice. A confirmation 
banner will pop up. Select Yes to save the changes or No to discard. 

7.1.1.5 Editing channels
The Edit function allows you to Sort, Rename or Delete channels. To enter the Edit menu, press BLUE 
while in TV Channel List. The Edit Channel menu will appear. 
If you made changes in the previous menu, but haven’t saved them yet, you will be asked to do so 
now.
Sort
Press RED to enter the Sort menu.
Use pq to select sorting method and press OK to confirm.
Possible methods are:
Name (A-Z): 	 Sorting in alphabetical order from A to Z.
Name (Z-A): 	 Sorting in alphabetical order from Z to A.
Free/Scramble:	 First in the list will be Free-To-Air channels.
Lock: 	 All unlocked channels will placed first in the list.
Default: 	 Sorting by searched Order (from lowest to highest frequency or by LCN 
numbering).

Rename
Press GREEN in Edit Channel to enable the Rename function. The Rename sign will move up to 
indicate that Rename is selected. Use pq to highlight a channel and press OK to select it. A text field 
will now pop up at the right of the screen. Use tu pq to select characters and enter them with 
OK. When you have finished editing, press BLUE to enter the changes. When all changes have been 
made, press EXIT twice. Select Yes to save the changes or No to discard.

Delete
Press BLUE in Edit Channel to enable the Delete function. The Delete sign will move up to indicate 
that Delete is selected. Use pq to highlight a channel and press OK to mark it for deletion. When 
you have marked all channels you wish to delete, press EXIT twice. A confirmation banner will be 
displayed. Select Yes to delete the marked channels or No to cancel.

7.1.2 Radio Channel List
Basically, the operation of the Radio Channel List is the same as in the TV Channel List. The only 
difference is that in Radio Channel List there is no video information, so it will always display the radio 
background on the preview screen.
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7.1.3 Delete all
Use this menu to delete all stored channels. Select Delete All with pq and press OK. The receiver asks 
you to enter the pin code. (DEFAULT PIN: 1234). Inside the confirmation window select Yes with tu 
and press OK to delete or select No to cancel. 

Warning!	� The Delete all function will permanently delete all current channels and all 
favourite lists from your receiver, and you are not able to leave the menu 
until you search for channels again.

7.1.4 Rename Favourite list
This menu allows you to personalize the names of the 8 available favourite lists. 
Use pq to select Rename Favourite List from the Edit Channel Menu and press OK to proceed. The 
names of all groups are now displayed. Select a favourite group with pq and press OK to edit its 
name. A text field will now pop up at the right of the screen. Use tu pq to select characters and 
enter them with OK. When you have finished editing, press BLUE to save the changes. When all 
changes have been made, press EXIT twice to leave this menu.

7.2 Installation

7.2.1 Auto Scan
Use pq to select Installation and press OK or u to advance.
Select Auto Scan with pq and press OK to enter.
Use tu to toggle between Yes or No. When FTA Only is set to Yes, scrambled channels won’t be 
stored in the channel list. Use pq to highlight Search. Now press OK to start the auto scan. 
The receiver will store all found channels in the channel list.

7.2.2 Channel Scan
Use pq to select Installation, press OK or u to advance.
Use pq to select Channel Scan and press OK to enter.
Use tu to toggle between the available scan modes: By Channel and By Frequency.
If By Channel is selected, use the cursor buttons to select Scan Band and Channel No. If By Frequency is 
selected, use the cursor buttons to select Frequency and Bandwidth. Highlight Search and press OK to 
start scanning. Newly found channels will be added to the channel list.

7.2.3 Antenna Power
Use pq to select Installation, press OK or u to advance.
Use pq to select Antenna Power and press OK to enter.
Set to On if you use an active antenna. 
Select Off for passive antennas.
When set to On, 5 V will be present on the ANT IN connector of the receiver. 
Press EXIT to leave the Antenna Power menu.
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7.2.4 LCN (Logical Channel Numbering)
If LCN (Logical Channel Numbering) is activated and an LCN signal is provided by the operator, 
channels will be stored in the operator defined order. Set LCN to On to activate the operator defined 
channel numbering or Off to store channels in the found order. This function only applies when a 
new channel search is performed.

7.3 System Setup
This menu allows you to manage the system settings of your receiver. It consists of the following 
sub-menus: Language, TV System, Local Time Setting, Timer Setting, Parental Lock, OSD Setting and Auto 
Standby.
Press pq to highlight the menu of choice and press OK advance to the next screen. Use pq to 
move the highlight to the setting of choice. Values can be changed with tu. Press EXIT to leave.

7.3.1 Language
This menu allows you to set up your language preferences. 
Language: 	 Use tu to select the language for the On Screen Display.
First Audio: 	 Use tu to select Audio language.
Second Audio: 	� Use tu to select a language that will be played when the language selected 

at First Audio isn’t available.
Subtitle Language : 	 Use tu to select the preferred subtitle language.
Teletext: 	 Use tu to select the preferred Teletext language (when available).
Subtitle: 	 Use tu to select the preferred subtitle type to be displayed automatically. 
Select Normal, Hard of Hearing or Off*

*Availability of DVB/HoH subtitles depends on the broadcast. If subtitles are not supported, they can be activated via 
Teletext if available.

7.3.2 TV System
Use this menu to match your receiver to your TV set. The following settings are available: 
Video Resolution: 	� Use this option to select the video resolution of your TV screen. The options 

are: By Source (automatic detection of video resolution offered to the 
receiver), By Native TV (automatic detection of maximal resolution of TV 
screen), and manual selections 480i, 576i up to 1080p. Use a setting that 
matches the specifications of your TV. After a selection is made, you will be 
asked to confirm. Selection above 576i is only applicable on HDMI output.

Aspect Mode:	� Use this option to select the aspect ratio of your TV and the preferred 
conversion method. The options are: Auto (automatic detection of aspect 
ratio), 4:3 Panscan (Displays 16:9 widescreen broadcasts full screen on your 
4:3 TV), 4:3 letterbox (black bars on top and under the picture on a 4:3 TV) and 
16:9 (use this setting for 16:9 TV sets). 

Connection: 	� Use this option to select the connection to your TV set. Select HDMI or TV 
SCART. If connection type HDMI is selected, then only the CVBS signal is 
available on the TV SCART.

Digital Audio Output: 	� Toggles between PCM and Bitstream output. When PCM is selected, all digital 
audio will be converted to stereo audio. Bitstream enables you to listen or 
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transfer Dolby® Digital/Dolby® Digital Plus* audio to the TV via HDMI or to a 
Home entertainment system (for example) through coaxial S/PDIF.

Note:	� Dolby® Digital Plus* is only available on the HDMI output. 

*Dolby and the double-D symbol are registered trademarks of Dolby Laboratories

7.3.3 Local Time Setting
Here you can set up your region and time zone.
Region: 	� Use tu to select the region you live in.
GMT Usage: 	� Set to By Region for broadcaster defined time, User Define to select manual a 

GMT zone or to Off to input time and date manually.
GMT Offset: 	� Allows you to adjust your time zone. This option is only available when 

GMT Usage is set to User Define.The GMT Offset range is "-11:30 ~ +12:00", 
increasing by half hours progressively. The cities matching the set GMT Offset 
are displayed at the bottom of the screen.

Daylight Saving: 	 Select On to add one hour for summer time.
Date:	� Date and Time settings are available only when GMT Usage is set to Off. Use 

the 0~9 buttons to enter the date. Press EXIT to proceed.
Time: 	� Date and Time settings are available only when GMT Usage is set to Off. Use 

the 0~9 buttons to enter the time. Press EXIT to proceed.
Time Display	 Select On to display time on screen, Off to remove.

7.3.4 Timer Setting
This menu allows you to set up to 8 timed events for recording or waking up the receiver.
Use pq to select Timer Setting from the System Setup menu and press OK to enter.
The receiver will display a list with 8 timers, followed by their respective status. Select the timer 
you wish to set or change with pq and press OK to proceed. The timer setup menu will now be 
displayed. 
The following settings are available:
Timer Mode: 	� Choose between Off the timer is inactive, Once, Daily (the timer will be 

executed every day, same time) or Weekly (the timer will be executed every 
week, same day, same time) and Monthly (the timer will be executed every 
month, same day, same time).

Timer Service: 	� Choose between Channel (the timer will wake up the receiver) or Record 
(Timer will start recording the scheduled event). 

Wakeup Channel:	 Use tu to select the channel the timer will wake up with.
Wakeup Date: 	 Use the 0~9 buttons to enter the date for the timed event.
Wakeup Time: 	 Use the 0~9 buttons to enter the starting time.
Duration:	 Use the 0~9 buttons to enter the duration of the timer.
When all settings have been made, use pq to move the highlight to Save and press OK to confirm. 
To quit the timer without saving your settings, move the highlight to Cancel.
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7.3.5 Parental Lock
This menu allows you to protect the installation menu and/or channels with a PIN code. You can also 
enter a new PIN code in the Parental Lock menu. 
Use pq to select Parental Lock from the System Setup menu and press OK to proceed. You will be 
asked to enter your PIN code. (DEFAULT PIN: 1234) 
Menu Lock: 	 Locks the installation menu. You can set Menu Lock to On or Off.
Parental Rating: 	� Choose between: Off, 4 years and up to 18 years. Channels with a parental 

rating above the chosen age will be protected with a PIN code (if available in 
your local broadcast.)

New Password:	 Enter your new PIN code (4 digits) here.
Confirm Password:	 Re-enter your PIN code here to confirm.

7.3.6 OSD Setting
This menu allows you to change settings for: OSD Timeout and OSD Transparency. 
OSD Timeout: 	� Sets the duration time of on screen banners and messages remove. The 

range is 1~10 seconds or Always On.
OSD Transparency:	 To set the OSD transparency from Off ~ 40% with 10% steps.
Load Default OSD Setting:
	� Press OK to clear all OSD settings and reset to default values.

7.3.7 Auto Standby
Auto Standby is a new feature that helps you reducing power consumption. When set to 30Min/1 
Hour/2 Hours or 3 Hours, the receiver will switch to standby if it doesn’t receive any commands during 
this time. Set Auto Standby to Off to deactivate the automatic standby function. 

7.4 Tools
Press MENU in viewing mode to enter the Main Menu.
Select the Tools submenu with pq and press OK or u to enter.
Use pq to highlight the submenu of choice and press OK proceed.
Press EXIT to leave.

7.4.1 Information
This submenu shows receiver specific information such as hardware version and software version. It 
also displays our web address www.strong.tv. Please have the Information screen on hand when you 
call our hotline. The person who answers your call might ask for the information given in this screen.

7.4.2 Load Factory Settings
This option allows you to reset the receiver to factory settings, which clear all stored channels.
Warning! By resetting your receiver to factory default, all your settings and stored channels will be 
permanently deleted. Please use this option with care.
Use pq to select Load Factory Settings in the Tools menu and press OK. You are asked to input your 
PIN code.
Input the correct PIN code using the 0~9  (DEFAULT PIN: 1234). A confirmation window is displayed. 
Select Yes to return to factory settings. Select No to cancel.
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Press EXIT to leave.

7.4.3 S/W Upgrade by OTA
This receiver is equipped with an Over The Air software upgrade function. An Over The Air update 
might not be available in your region. Please visit our website www.strong.tv or contact your local 
service hotline for more information about this option.

7.4.4 Upgrade by USB
This feature allows you to upgrade receiver software via the USB port. When new software is available 
for your receiver, it can be downloaded from our website www.strong.tv. Place the software file 
(unzipped) in the root directory of your USB storage device (HDD, memory stick etc.) and connect the 
device to the USB port of the receiver. Select Upgrade by USB from the Tools menu and press OK to 
proceed. The upgrade menu will now be displayed. 
Use pq to select Update Mode and choose option Allcode.
Use pq to select Upgrade File and choose the file containing the latest and correct software.
When all settings have been made, move the highlight to Start and press OK to start the upgrade 
process. After a few seconds, the receiver asks: “Are you sure to burn flash?”. Select Yes to finalize the 
upgrade or No to quit without upgrading.

Note:	� If, after a software upgrade, the receiver should behave in an unexpected 
way, please perform a factory reset as well. See chapter 7.4.2.

Warning!	� After an update the receiver restarts automatically. During the upgrade 
process NEVER disconnect the receiver from the mains or switch off the 
power! Doing so might damage your receiver  and will void warranty! 

7.4.5 Channel Dump and Load function
This feature allows you to load a channels list quickly and use a channel list that previously was 
created on this (backup) or another receiver from the same model via the USB port. This is useful 
when more receivers have to be installed in the same region, thus omitting a full scan and (optional) 
sorting of channels. It is also useful as a backup for your own unit.

Channel Dump function (backup to USB)
Have a storage device connected to the USB port of the receiver. Select Upgrade by USB from the 
Tools menu and press OK to proceed. The upgrade menu will now be displayed. 
Use pq to select Update Mode and choose the option Dump channel list.
Use pq to select Upgrade File. A DataBase file name containing date and time will be presented, 
format DBYYYYMMDDHHMM (DateBaseYearMonthDateHourMinute.udf).
Use pq to select Start and press OK to proceed. The channel list and favourites will be saved.
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Update Channel list function (read from USB)
Have the storage device connected to the USB port of the receiver, containing a previously made 
channel list on this unit or another of the same model. Select Upgrade by USB from the Tools menu 
and press OK to proceed. The upgrade menu will now be displayed. 
Use pq to select Update Mode and choose the option Update Channel list.
Use pq to select Upgrade File. Select the correct database file name, format DBYYYYMMDDHHMM 
(DateBaseYearMonthDateHourMinute.udf).
Use pq to select Start and press OK to proceed. Confirm the upgrade with OK to proceed.  

Warning	� Old channel list and favourites will be overwritten.

After completion, the unit will reboot and come back with the first channel in the new channel list.

7.4.6 Auto-update OTA
If set to On the unit will check automatically at the moment of going to stand-by for an Over The Air 
software upgrade.
An Over The Air update might not be available in your region. Please visit our website www.strong.tv 
or contact your local service hotline for more information about this option.

7.5 Games
Your receiver is equipped with two games which can be played on your TV screen using the receiver 
remote control.
Use pq to select Games from the Main menu and press OK or u to proceed.
Select one of the available games (Othello or Sudoku) using pq and press OK to start the game. 
Follow the directions on screen. Press EXIT to quit a game.

7.6 Media 
The Media menu consists of the following submenus: Media Player, HDD Information, DVR Setting and 
Remove USB device safely.
Use pq to highlight the menu of choice and press OK to enter. Press EXIT to quit.

7.6.1 Media Player
This function allows playback of different kind of files from the connected USB storage device. In the 
Media menu, select Media Player and press OK to enter this menu.
When entering the media player, the highlight is on the USB storage device. Press q and OK to open 
the directory respectively its folders/subfolders.
First select which files you like to play back. Press 1 to switch between Video/Record/Music or Image. 
Press pq to select a file or folder and then press OK to open the folder/subfolder (if applicable) or 
start playback of the file. Press the EXIT button to exit.
Use the buttons like described below in order to choose functions during the different playback 
modes (like described in the help banner below): 
Video:
INFO:	� Press the INFO button to set repeat mode. The options are repeat folder 

folder icon/repeat once 1 or no repetition (no icon shown).
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1:	� During the playback of a movie with external subtitles, press 1 to enter 
the subtitle menu. In this menu you can select size and colours of your 
preference.

2:	 Press 2 to open the Sort menu. You can sort by Name/Time or Size.
7:	� Press 7 to open the Edit menu. This menu allows accessing the following 

functions by entering the number: rename 4, copy 5, delete 6, create folder 7. 
EXIT:	 One step back or leave the folder and quit the function.
Record:
2:	 Press 2 to enter a new name for the selected recording.
3:	� Highlight the recording that you want to lock. After pressing 3 you will be 

asked to input your PIN code. DEFAULT PIN: "1234". After entering your PIN 
code, the recording is locked. If you want to unlock the recording again, press 
3 again.

4:	� Press 4 to mark the recording you want to delete. By selecting the same 
recording and pressing 4 again you can remove the delete marker again. 
Press EXIT to delete. 

EXIT:	 One step back or leave the folder and quit the function.
Music:
4: 	� Press 4 to open a previously created play list. Then you can select the music 

file that you want to add your play list by pressing 5 (a single file will be 
added to the play list) or 6 (all files of this directory/folder will be added to the 
play list).

5:	� Press 5 to add a file to the playlist. A favourite icon will be shown next to the 
file.

6: 	� Press 6 to add all files of this directory/folder to the play list. Press 6 again to 
delete all files from the play list.

7:	� Press 7 to open the Edit menu. This menu allows access to the following 
functions by entering the number: rename 4, copy 5, delete 6, create folder 7.

2:	 Press 2 to open the sort window. You can sort by Name/Time/Size and 
Favourite.
INFO:	� Press the INFO button to set repeat mode. The option is Repeat Folder/

Random Folder/Repeat One.
EXIT: 	� One step back or leave the folder and quit the function.
Image:
4:	� Press 4 to open a previously created play list. Then you can select the image 

file that you want to add your play list by pressing 5 (a single file will be 
added to the play list) or 6 (all files of this directory/folder will be added to the 
play list).

5:	 Press 5 to add a file to the play list. A favourite icon will be shown next to the 
file.
6:	� Press 6 to add all files of this directory/folder to the play list. Press 6 again to 

delete all files from the play list.
7:	� Press 7 to open the Edit menu. This menu allows access of the following 

functions: rename 4, copy 5, delete 6, create folder 7.
2:	� Press button 2 to open the sort window. You can sort by Name/Time/Size 

and Favourite.
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INFO:	� Press INFO to access slideshow settings. You can change the slide time and 
slideshow repetition.

3:	 Press 3 to show the files in a preview of 3x3 pictures.
EXIT:	 One step back or leave the folder and quit the function.

7.6.2 HDD Information
This option shows relevant information about the connected USB device. In this menu you can also 
format your USB storage device and setup the recording type. Select HDD Information in the Media 
menu and press OK to enter. Now you will see all details as Free and the used Recording Sizes and the 
used file system. Press the YELLOW button Format to format the connected USB device. Please, enter 
your PIN code to access this menu and press OK to start formatting.

Warning!	� Formatting will permanently delete ALL data stored on the connected 
device. Please make a backup copy of all data you wish to keep before 
entering the HDD Format menu. STRONG cannot be held responsible for 
loss of data from USB devices used with this receiver. 

Press OK to proceed, select FAT or Cancel, or press EXIT to leave without formatting. 
Press BLUE DVR Set to select recording type. 
Select REC & TMS to store recordings and Timeshift copies to your HDD.
Select Record to store only recordings to your HDD. 
Select Timeshift to switch recordings OFF. Only the Timeshift function is active.

Note	� It is possible to use USB storage devices already formatted in NTFS.

Press EXIT to leave this menu.

7.6.3 DVR Setting
This menu allows you to configure settings for Timeshift, recording and playback.
Select DVR Setting in the Media menu and press OK to enter.
Use pq to move the highlight and tu to change settings.
Timeshift:	� Select between Auto, Pause or Off. When Timeshift is set to Auto it will 

automatically start every time after tuning to a channel. When Timeshift is set 
to Pause it will start only after pressing the YELLOW/2 button. Select Off to 
deactivate Timeshift.

Step to:	� 30 sec to 30 min. Set the time step you like to jump forward to by pressing 4 
during playback of recorded files. This only works when the info banner is 
displayed on screen. If it is not, press INFO.

Timeshift to Record:	� If set to On the timeshifted part will be included in your recording when you 
start to record the current programme.

PS Record:	� Select between On or Off. When Off is selected, recordings will also include 
subtitles and Teletext (when available). Record to PS mode On allows 
recordings without these extras and will need less space on your USB device.

Press EXIT to leave this menu.
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7.6.4 Remove USB device safely
Select Remove USB device safely from the tools menu and press OK. The receiver will display a 
message indicating that you can safely remove your storage device from the receiver. 

Note	� After performing this function, the USB device is no longer accessible from 
your receiver. To gain access to your storage device again, re-insert it or 
switch the receiver to standby and on again.

8.0 Troubleshooting
There may be various reasons for abnormal operation of the receiver. Check the receiver according to 
the procedures shown below. If the receiver does not work properly after checking it, please contact 
your dealer or the local Service Hotline. Do NOT try to open or disassemble the receiver. It may cause 
a dangerous situation and warranty will be void.

Problem Possible cause What to do 

The LED indicator 
does not lit

Mains lead is unplugged Check the mains plug

No signal found

The antenna is disconnected
The antenna is damaged/
misaligned
Out of digital signal area
The active antenna requires the 
antenna power/external power 
to be switched ON

Check the antenna lead
Check the antenna
Check with your dealer
Switch the antenna power of the 
receiver ON/connect external 
power

No picture or sound 
on TV or amplifier

HDMI or SCART are not 
selected on your TV or the 
amplifier or unit are set to a 
higher resolution than the TV 
supports.
TV/amplifier are not switched 
on

Switch to the correct TV/amplifier 
input
Select a lower resolution on the 
receiver
Switch the TV/amplifier on.
Check if the S/PDIF connection 
is used.

Scrambled channel
message

The channel is scrambled Select an alternative channel

No response to the 
remote control

The receiver is off
The remote control is not 
aimed correctly
The front panel is obstructed
The batteries of the remote 
control are exhausted

Plug in and turn on the plug
Aim the remote control at the 
front panel
Check for obstructions
Replace the batteries of the 
remote control
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Forgotten PIN code
Forgotten channel  
lock code

Default PIN is 1234
Contact the local Service Hotline 
or send an email to our Support 
via www.strong.tv

After moving the 
receiver to another 
room/area you are no 
longer able to receive 
digital reception

The antenna signals are too 
weak
The signal strength/quality 
might be less than before, if 
using an indoor antenna. 

Press INFO on the remote 
control 3x to call up the signal 
bars and adjust the antenna for 
(maximum) reception
or rescan channels
When using an active antenna, 
check antenna power.
Try to use an outdoor antenna.

The receiver switches 
off automatically.

The Auto Standby function is 
enabled.

Disable the auto standby. See 
section 7.3.7 for details.

Playback of video (or 
Timeshift) is causing 
picture freeze/macro 
blocks or similar 
distortion, especially 
on HD content. 

The reading/writing speed 
of your USB device may be 
too low.

Make sure to use a USB storage 
device with sufficient speed and 
space. Pen drives (‘USB sticks’) 
may not support sufficient speed.

9.0 Technical Specifications
Demodulator
Demodulator: 	 COFDM; 16 QAM/64 QAM, QPSK
Transmission mode: 	 2 K - 8 K

Video Decoder
Profile level: 	 MPEG-2 MP@ML, AVC/H264HP@L4.1, MPEG4 ASP supported   
Video resolutions:	 480i, 480p, 576i, 576p, 720p, 1080i, 1080p, By Native TV, By source
Decoding & Video out:	 PAL 
Aspect ratio: 	 4:3 Letterbox, 4:3 Pan & Scan, 16:9, Auto

Audio Decoder
Audio support:	 AAC/Dolby Digital Plus*/AC3/PCM/AC3+
MPEG MusiCam Layer II
Sampling rate: 	 32, 44.1, 48 KHz
Audio mode: 	 Stereo, Mono

*Dolby and the double-D symbol are registered trademarks of Dolby Laboratories
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Tuner
Front End: 	 DVB-T, UHF & VHF Tuner 
Input frequency range: 	 174 – 230 MHz (VHF) and 470 - 862 MHz (UHF)
Loop through frequency range: 	 47 - 862 MHz
Input signal level: 	 -20 ~ -84 dBm

Memory and System 
Flash memory: 	 4 MB
SDRAM: 	 64 MB

Multimedia
Video playback:	� MPEG-1 and MPEG-2 encoded (mpg), VOB, AVI, MKV, TS, M2T, 

M2TS, MPEG-4 and MOV* 
Audio playback:	 MP3, OGG*
Picture view:	 BMP, JPEG*

*STRONG cannot guarantee the playback of all files although extensions are listed, as it depends on codec used, data bit 
rate and resolution (all MPEG codec formats are supported).

Connectors
ANT IN - IEC Female
ANT OUT - IEC Male
HDMI 
TV SCART (RGB, CVBS, Audio L&R)
S/PDIF (coax.)
mm stereo audio jack (audio left/right)
USB 2.0 port: 5 V/800 mA (max.) supported

General Data
Supply voltage:	 220 - 240 V AC (SMPS), 50/60 Hz 
Power consumption: 	 3.65 W (typ.), 12.00 W (max)
Power consumption in standby: 	 max. 0.4 W
Operating temperature: 	 0 °C ~ +40 °C
Storage temperature: 	 -10 °C ~ +50 °C
Operating humidity range: 	 10~85%, RH, Non-condensing
Size (WxDxH) in mm: 	 147 x 122 x 35
Net-weight: 	 0.25 kg

STRONG declares that this item complies with the basic requirements and other relevant regulations of directives 
2004/108/EC and 73/23/EC, RoHS 2002/95/EC

Subject to alterations. In consequence of continuous research and development technical specifications, design and 
appearance of products may change. HDMI, the HDMI logo and High-Definition Multimedia Interface are trademarks or 
registered trademarks of HDMI Licensing LLC in the United States and other countries. Manufactured under license from 
Dolby Laboratories. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories. All other product 
names are trademarks or registered trademarks of their respective owners. © STRONG 2015. All rights reserved.
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HOTLINE

BG +359 32 634451
support_bg@strong.tv

DK support_dk@strong.tv

NL support_nl@strong.tv

AT 0820 400 150
support_at@strong.tv

€ 0,12/Min. österr. Festnetz

DE 0180 501 49 91
support_de@strong.tv

€ 0,14/Min. deutsches Festnetz
€ 0,42/Min. max. Mobilfunknetze

+36 1 445 26 10
support_hu@strong.tvCEE

PL 801 702 017
support_pl@strong.tv

UA +380(44)228 24 73
support_ua@strong.tv

FR 0826 029 928
support_fr@strong.tv

€ 0,15 par mn poste fixe en France

IT 199 404 032
support_it@strong.tv

Da rete fissa 24,8 cent. al min.
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Da rete mobile max 49 cent. al min.
15,6 cent. scatto alla risposta
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